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Hướng dẫn sử dụng Mapinfo

I. Khái quát về hệ thống thông tin địa lý GIS và MAPINFO.
Hệ thống thông tin địa lý (Geographic Information System) là một hệ thống 

với sự trợ giúp của máy tính phục vụ cho mục đích thu thập, xử lý, phân tích, lưu 
trữ và hiển thị các loại dữ liệu mang tính chất không gian cũng như phi không gian 
(như vị trí, hình dạng, các mối quan hệ về không gian như kề nhau, gần nhau, nối 
với nhau .v.v).

Các bộ phận cấu thành lên một hệ thống thông tin địa lý GIS.
- Phần cứng máy tính.
- Các chương trình phần mềm GIS để:

+ Vào dữ liệu.
+ Lưu trữ và quản lý dữ liệu.
+ Phân tích, xử lý dữ liệu.
+ Hiển thị, xuất dữ liệu.
+ Giao diện với người dùng.

- Người vận hành các thiết bị.
Mapinfo là một trong các phần mềm đang được ding như là một hệ GIS 

trong quản lý thông tin bản đồ.
Mapinfo: hiển thị, in ấn, tra cứu các thông tin không gian và phi không gian 

trong một khu vực không gian làm việc nào đó (WORKSPACE).
II. Giới thiệu phần mềm MAPINFO.
1. Các dữ liệu trong MAPINFO.
Khi người dùng tạo ra các table trong Mapinfo, lưu cất các WORKSPACE, 

nhập hoặc xuất dữ liệu. MAPINFO sẽ tạo ra rất nhiều các file với các phần mở rộng 
khác nhau. Các file dữ liệu trong MAPINFO bao gồm:

- Tên file *.DAT File dữ liệu dạng bảng tính cho một table format của 
MAPINFO.

- Tên file *.MAP Chứa thông tin địa lý mô tả các đối tượng trên bản đồ.
- Tên file *.TAB Đây là các file chính cho các table của MAPINFO nó 

được kết hợp với các file khác như .DAT, DBF…
- Tên file *.ID File  index  cho  các  đối  tượng  đồ  hoạ  của  MAPINFO  (file 

*.DAT).
- Tên file *.DBF File dữ liệu bảng tính format dBASE.
- Tên file *.MID Format  nhập/xuất  dữ  liệu  dạng  bảng  của  MAPINFO, 

file *.MID kết hợp với file .MIF.
- Tên file .MIF Format nhập/xuất cho các đối tượng đồ hoạ của MAPINFO, 

file *.MIF kết hợp với file .MID.
Tên file *.TXT File bảng thuộc tính format ASCII.
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Tên file *.WKS File thuộc tính format Lotus 1, 2, 3.
Tên file *.WOR File lưu Workspace trong Mapinfo.
2. Các khái niệm  của hệ thông tin địa lý GIS trong MAPINFO.
Các đối tượng trên bản đồ được chia ra thành các lớp (LAYER). Một lớp 

chứa các đối tượng có chung các thuộc tính cần quản lý và cách lưu các thuộc tính 
này trong máy tính là dưới cùng một dạng (FORMAT).

Các đối tượng không gian được chia thành 4 loại sau:
+ Điểm (POINT).
+ Đường (LINE).
+ Vùng (POLYGON).
+ Chữ (TEXT)

Cách thể hiện 4 loại đối tượng không gian trên trong MAPINFO:
+ Điểm : Xác định bằng một vị trí trong không gian (X, Y). Điểm 

được thể hiện bằng các ký hiệu (SYMBOL), màu sắc (COLOR), kích kỡ (SIZE).
+ Vùng : xác định bằng chuỗi các cặp toạ độ của các đường bao khép 

kín  trong  không  gian  (Xi,  Yi).  Vùng  được  thể  hiện  bằng  các  loại  tô  màu 
(PATTERN), màu sắc (COLOR).

+ Chữ : Xác định bằng một cặp toạ độ trong không gian (X, Y) và một 
dòng chữ. Chữ được thể hiện bằng các kiểu chữ (FONT), màu sắc (COLOR), kích 
cỡ (SIZE), góc nghiêng chữ (ENGLE).

Dữ liệu mỗi lớp chia thành 2 loại:
- Dữ liệu phi không gian (Attribute Data) lưu dưới dạng một bảng hàng cột 

(Brown).
- Dữ liệu không gian (Spatial Data) lưu dưới dạng bản đồ đã được số hoá 

(Map).
3. Cách tổ chức thông tin trong MAPINFO.
Như đã đề cập ở trên dữ liệu trong MAPINFO được chia thành 2 loại dữ liệu 

không gian và phi không gian. Trong MAPINFO mỗi loại dữ liệu trên có phương 
thức tổ chức thông tin khác nhau.

a. TABLE (Bảng).
Trong MAPINFO dữ liệu không gian cũng được phân ra thành các lớp thông 

tin khác nhau (layer), mỗi lớp thông tin không gian được đặt trong một TABLE. 
Người dùng có thể thực hiện các thao tác đóng, mở, sửa đổi, lưu cất … các TABLE 
này.

Để tạo thành một TABLE cần có ít nhất là 2 file, file thứ nhất .TAB chứa 
toàn bộ các cấu trúc của dữ liệu, file thứ hai .DAT chứa dữ liệu thô (gốc). Nếu trong 
một TABLE có chứa các đối tượng đồ hoạ sẽ có 2 file nữa đi kèm, file .MAP mô tả 
các đối tượng đồ hoạ và file .ID chứa các tham số chiếu liên kết giữa dữ liệu với các 
đối tượng đồ hoạ. Một số các TABLE còn có thể thêm file .IND file này cho phép 
người sử dụng tìm kiếm đối tượng trên bản đồ bằng lệnh Find.
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b. WORKSPACE (Vùng làm việc).
Khái niệm thứ 2 cần quan tâm trong MAPINFO là các WORKSPACE. Mỗi 

TABLE trong MAPINFOR chỉ chứa chứa 1 lớp thông tin, trong khi đó trên 1 không 
gian làm việc có rất nhiều lớp thông tin khác nhau. WORKSPACE chính là phương 
tiện để gộp toàn bộ lớp thông tin khác nhau lại tạo thành 1 tờ bản đồ hoàn chỉnh với 
đầy đủ các yếu tố nội dung, hơn thế nữa 1 WORKSPACE còn có thể chứa các bảng 
tính, các biểu đồ, layout.

c. BROWSER (bảng hiển thị dữ liệu thuộc tính).
Dữ liệu thuộc tính mô tả cho các đối tượng không gian trong MAPINFOR 

được chứa trong các d mỗi d là một bảng tính có các hàng và cột (với hàng là các 
bảng ghi và cột là các trường dữ liệu). Các d thường đi kèm với các TABLE. 

d. MAP (cửa sổ hiển thị dữ liệu bản đồ)
Dữ liệu bản đồ (địa lý) của các đối tượng không gian nhằm mô tả vị trí, hình 

dáng trong một hệ thống toạ độ nhất định. Một cửa sổ MAP cho phép hiển thị cùng 
một lúc nhiều lớp thông tin (Layer) khác nhau hoặc bạt tắt hiển thị một lớp thông tin 
nào đó.

e. LAYOUT (trình bày in ấn)
Cho phép người sử dụng kết hợp các browser, các cửa sổ bản đồ, biểu đồ và 

các đối tượng đồ hoạ khác vào một trang in từ đó có thể gửi kết quả ra máy in hoặc 
máy vẽ. 

4. Công cụ làm việc trong MAPINFOR
MAPINFOR cung cấp cho người dùng 3 thanh công cụ để làm việc với các 

đối tượng bản đồ. Việc sử dụng chúng rất đơn giản, người dùng chỉ việc bấm lên 
công cụ cần thiết để chọn lệnh. Người dùng có thể định lại kích thước các thanh 
công cụ bằng cách bấm và kéo khung của mỗi thanh, di chuyển chúng trên màn 
hình  bằng  cách  bấm và  kéo  trên  thanh  tiêu  đề.  Người  dùng  có  thể  dùng  lệch 
Toolbars trong menu Options để tắt hoặc hiển thị các thanh công cụ.

a. Thanh công cụ chính (Main toolbar).
Thanh công cụ chính bao gồm các công cụ để chọn đối tượng thay đổi tỷ lệ 

hiển thị của bản đồ trong cửa sổ, tra cứu thông tin về đối tượng trên bản đồ, xác 
định khoảng cách giữa các đối tượng. Trong thanh này còn có các nút lệnh cho phép 
người dùng thay đổi thuộc tính của layer (Editable, Visible... ), mở bảng chú giải 
hoặc cửa sổ có số liệu thống kê.
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Nút < thay đổi tỷ lệ hiển thị> (Change View button). 
Truy nhập vào hội thoại Change View, ở đây người dùng có thể đặt 
các xác lập như độ rộng cửa sổ, tỷ lệ bản đồ ... để điều khiển việc 
hiển thị các đối tượng trên màn hình. (Tương đương với tự chọn 
lệnh Change View trong Menu MAP).

Nút <Kéo> (Grabber button).Sử dụng công cụ (kéo) để thay đổi lại 
vị trí của bản đồ hoặc layout trong cửa sổ đang hiển thịNút <Tra cứu thông tin> (info tool button).

Công cụ này cho phép người dùng xem dữ liệu dạng bảng kết hớp 
với các đối tượng bản đồ trong MAPINFONút <Nhãn> (Label button).
Người dùng có thể sử dụng công cụ <Nhãn> để gán nhãn cho các 
đối tượng đồ hoạ bằng các thông tin lấy từ cơ sở dữ liệu quan Hệ.

Nút <Điều khiển layer> (Layer contron button).
Truy nhập vào hộp thoại Layer contron để chỉ định và kiểm soát 
toàn bộ các table trong cửa sổ bản đồ đang được hiển thị. Trong 
hộp thoại này người sử dụng có thể đặt các tuỳ chọn như hiển thị 
hoậc không hiển thị các đối tượng đồ học trong một layer (Visible), 
chọn layer để sửa chữa (Editable) cho phép chọn hay không các đối 
tượng đồ hoạ trên bản đồ, đặt các xác lập hiển thị cho từng kiểu đối 
tượng có trong layer (đường, điểm, vùng, text), sắp xếp lại thứ tự 
các layer đang hiển thị trong cửa sổ bản đồ, thêm vào hoặc bớt đi 
(Add, remove) trong cửa sổ đang hiển thị một hay nhiều layer...
Nút <Chú giải> (Legend button).
Chọn nút này để mở một cửa sổ hiển thị nội dung bảng chú giải cho 
các bản đồ hoặc biểu đồ.

Nút <Chọn theo đường bao> (Boundary Select button)
Giống như nút chọn trên nhưng khu vực chọn và tìm kiếm ở đây 
được xác định bằng một vùng có hình dạng bất kỳ do người dùng 
xác định.

Nút <Chọn theo bán kính> (Radius Select button)
Công cụ (chọn theo bán kính cho phép thực hiệ việc chọn và tìm 
kiếm đối tượng bản đồ nằm trong một vùng hình tròn mà người 
dùng chỉ định.

Nút <Chọn> (Select button)
Nút <Chọn> được dùng dể chọn các đối tượng (object) hay bản ghi 
(Record) trong cửa sổ bản đồ layout hoặc Browser
Nút <Thước> (Ruler button)
Sử dụng công cụ này để xác định khoảng các giữa hai điểm
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b. Thanh công cụ vẽ (DRAWING)
Thanh này chứa các công cụ và các lệnh sử dụng khi tạo và sửa chữa các đối 

tượng bản đồ.
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Nút <ấn định các đối tượng đã chọn> (assign Selected Object) 
Công cụ này chỉ dùng khi thực hiện lệnh Redistricting (phân nhỏ) 
nó cho phép ấn định toàn bộ các đối tượng đã được chọn thành 
<Target> (đích).

Nút <đặt đối tượng đích phân nhỏ trên bản đồ> (Set Target District 
from Map button).
Công cụ này chỉ dùng khi thực hiện lệnh Redistricting (phân nhỏ) 
nó cho phép ấn định toàn bộ các đối tượng đã được chọn thành 
<Target> (đích).

Nút <Thống kê> (Statistics button) 
Nút <Thống kê> cho phép truy nhập vào cửa sổ Statistics trong đó 
người dùng có thể thấy được tổng, trị trung bình... của toàn bộ các 
cột số liệu cho một đối tượng đang được chọn trong cửa sổ hiển thị 
bản đồ.

Nút <Phóng to> (Zoom-in button) 
Công cụ này được sử dụng để phóng to bản đồ hoặc layout, thuận 
tiện cho việc quan sát các đối tượng bản đồ.

Nút <Thu nhỏ> (Zoom-out button) 
Ngược lại với công cụ trên, nút này sẽ thu nhỏ bản đồ hoặc layout 
lại để quan sát tổng quan các đối tượng.

Nút <Thêm Node> (Add Node button) 
Công cụ này cho phép người sử dụng thêm một node vào đối tượng 
dạng vùng, đường khi đang làm việc trong chế độ định lại hình 
dáng đối tượng (Reshape mode).

Nút <Cung> (Arc button) 
Sử dụng công cụ <cung> để vẽ một cung theo kích thước và hình 
dạng cung một phần tư đường tròn hay elip.

Nút <Elip> (Elipse button) 
Công cụ tạo các đối tượng hình elip hoặc hình tròn.  (Muốn tạo 
thành hình tròn nhấn và giữ phím Shift trong khi vẽ).

Nút <Khung> (Frame button) 
Công cụ cho phép người sử dụng tạo ra các khung trong cửa sổ 
layout để hiển thị các cửa sổ bản đồ, biểu đồ, bảng tính, chú giải, 
công cụ hiển thị, số liệu thống kê, các thông báo.

Nút <Vùng> (Polygon button) 
Công cụ được sử dụng vẽ các vùng khép kín, được tạo bởi các 
đường nối lại với nhau.

Nút <Kiểu đường> (Line Style button) 
Chọn nút <Kiểu đường> để truy nhập vào hộp thoại Line Style 
trong đó người dùng có thể thay đổi kiểu (Style), màu (Color) và 
lực nét (Width) của các đối tượng dạng đường.

Nút <Đa đường> (Polyline button) 
Sử dụng để vẽ các polyline có thể hở hoặc đóng kín khi nối với các 
đường khác.

Nút <Vẽ hình chữ nhật> (Rectangle button) 
Chọn công cụ <vẽ hình chữ nhật> để tạo các đối tượng có dạng 
hình chữ nhật hoặc hình vuông trên bản đồ (Muốn tạo ra các hình 
vuông nhấn và giữ phím Shift khi vẽ hình).

Nút <Kiểu vùng> (Region Style button) 
Chọn nút để truy nhập vào hộp thoại Region Style, trong đó người 
sử dụng có thể thay đối pattern tô lòng đối tượng vùng (Fill 
Pattern), màu và nền (Color and blackground). Kiểu (Border Style), 
màu (Color) và độ rộng (Width), đường bao ngoài của đối tượng 
vùng.

Nút <Định lại hình dạng> (Reshape button) 
Cho phép người sử dụngbật hoặc tắt chế độ định dạng lại đối tượng 
khi cần sửa các đối tượng vùng,  đường, polyline, cung và điểm 
bằng cách thêm vào xoá đi hoặc di chuyển các node dùng để xác 
định các đối tượng đó.

Nút <Vẽ hình chữ nhật có góc cong> (Rounded Rectangle button) 
Sử dụng khi cần tạo ra các đói tượng có dạng hình chữ nhật hoặc 
hình vuông với các góc được vuốt cong.

Nút <Ký hiệu> (Symbol button) 
Sử dụng để tạo ra các đói tượng có dạng điểm thể hiện trên bản đồ 
bằng các ký hiệu.

Nút <Kiểu ký hiệu> (Symbol Style button) 
Truy nhập vào hộp thoại Symbol Style, trong đó người sử dụng có 
thể thay đổi kiểu (Style, màu (Color), kích thước (Size) của các ký 
hiệu.

Nút <Text> (Text button) 
Sử dụng để tạo ra các tiêu đề, các nhãn, các ghi chú khác có trên 
bản đồ và layout.Nút <Kiểu Text> (Text Style button) 
Truy nhập vào hộp thoại Text Style, trong đó người sử dụng có thể 
thay đổi kiểu chữ (Font), kích thước (Size), màu (color)... của các 
đối tượng dạng Text.

Nút <Chạy chương trình MAPBASIC> (Run Mapbasic Program 
button) 
Truy nhập hộp thoại Run Mapbasic Program, trong đó người sử 
dụng có thể chọn ứng dụng để chạy trong MAPINFO

Nút <Hiển thị cửa sổ Mapbasic> (Show Mapbasic Window button) 
Cho phép hiển thị hoặc không hiển thị cửa MapBasic.

Nút <Chọn Marquee> (Marquee select button)
Công cụ cho phép người sử dụng có thể thực hiện việc chọn và tìm 
kiếm các đối tượng bản đồ trong một khu vực được chỉ giao bằng 
một hình chữ nhật (Marquee box).
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III. Các chức năng chính của MAPINFO.
Các chức năng của MAPINFO được phân theo các nhóm như sau:

1. Vào dữ liệu (INPUT).
2. Cập nhật sửa chữa dữ liệu (UPDATE).
3. Hiển thị dữ liệu (VIEW).
4. Tra cứu (QUERY).
5. In ấn (PRINT).
6. Nhập, Xuất (IMPORT, EXPORT).

A/ Vào mới dữ liệu (Input).
Dữ liệu trong MAPINFO được phân làm hai loại:
- Cơ sở dữ liệu không gian (là các bản đồ).
- Cơ sở dữ liệu thuộc tính (là các thông tin mô tả cho các đối tượng có trong 

cơ sở dữ liệu không gian).
Cách vào dữ liệu không gian:
- Vào trực tiếp qua MAPINFO: cài đặt thiết bị qua bản vẽ (Digitizer) vào 

môi trường windows và dùng các lậnh tạo mới các đối tượng của MAPINFO để vào 
bản đồ.

-  Vào qua các  chương trình  số hoá  khác như Microstation,  AUTOCAD, 
DesignCAD... Sau khi số hoá xong phải chuyển dữ liệu sang format trực tiếp của 
MAPINFO hoặc chuyển sang dạng DXF của ACAD, sau đó dùng lệnh IMPORT 
của MAPINFO để chuyển sang dạng dữ liệu của MAPINFO.

Cách vào dữ liệu phi không gian.
- Vào trực tiếp trong MAPINFO. Hiển thị bảng dữ liệu lên trên màn hình 

(như lệnh Browser trong FOXPRO).
-  IMPORT  từ  file  dạng  DBF  của  FOXPRO  hoặc  DBF  của  ACCESS, 

EXCEL.
B. Hiển thị dữ liệu 

Toàn  bộ  dữ  liệu  được  lưu  trong  một  khoảng  không  gian  làm  việc 
(WORKSPACE). WORKSPACE bao gồm các bảng dữ liệu thuộc tính, các lớp dữ 
liệu không gian hiển thị trên cùng một cửa sổ (WINDOWS) chồng (OVERLAY) 
lên nhau hay mỗi lớp ở một cửa sổ khác nhau.

Với sự trợ giúp của môi trường WINDOWS nên cùng một lúc người dùng 
có khả năng quan sát nhiều cửa sổ khác nhau trên màn hình.

Các thao tác với các cửa sổ hiển thị (như thu, phóng, di chuyển…) cũng 
giống như với bất kỳ ứng dụng nào chạy trên hệ điều hành Windows.
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Mở một cửa sổ mới:

Thông thường trên máy khi trao sản phẩm cho người dùng, mọi thông tin 
được lưu trong một WORKSPACE. Vì vậy khi muốn xem toàn bộ thông tin hiện có 
chỉ cần mở một WORKSPACE.

Thao tác mở cửa sổ WORKSPACE

- Chọn menu FILE (bằng con trỏ hoặc ấn ALT+F)

- Chọn Open Workspace (bằng con trỏ hoặc ấn W)

Trên màn hình hiện ra một cửa sổ hội thoại, người dùng xác định đường 
dẫn tới vùng chứa thông tin và tên file WORKSPACE cần mở. Chọn xong, trên 
màn hình xuất hiện cửa sổ hiển thị dữ liệu không gian cho một WORKSPACE và 
các cửa sổ bằng (TABLE BROWSE) chứa các dữ liệu phi không gian cần thiết 
tương ứng trên WORKSPACE (có thể có hoặc không).

A. Các thao tác hiển thị dữ liệu phi không gian (Browser)

Dữ liệu phi không gian hiển thị trên một cửa sổ dưới dạng một bảng. Thao 
tác  với  bảng  này  người  dùng  thao  tác  như  với  một  số  cửa  sổ  điển  hình  của 
WINDOWS: thu phóng, di chuyển, scroll.v.v…

B. Các thao tác hiển thị dữ liệu không gian

a. Mở một lớp thông tin (Open Table):

Muốn làm việc với MAPINFO việc đầu tiên cần tiến hành là mở một file 
hoặc table, có chứa các thông tin bạn sẽ làm viêc, để mở một table:

Trong menu file chọn Open Table (hoặc bấm phím nóng <Ctrl + O>) để mở 
hộp thoại Open Table

Chú ý: Nếu đang ở hộp thoại Quick Start (hộp thoại hiển thị đầu tiên ngay 
sau khi khởi động MAPINFO). Chọn nút Open và Table (mở table), bấm OK để 
hiển thị hộp thoại Open Table.

Nhưng chỉ định trong hộp thoại Open Table phụ thuộc vào:

- Người sử dụng sẽ mở một table để tồn tại?

- Sẽ nhập dữ liệu vào MAPINFO lần đầu tiên?

Sau đó chỉ định đường dẫn và tên table muốn mở.

b. Thay đổi tỷ lệ xem

Thay đổi qua bảng công cụ (Tool Palette)
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* Phóng to (Zoom in): Chọn con trỏ phóng (Zoom in cursor)

Cách một: Tự động phóng to gấp đôi hai lần. Chọn biểu tượng và đặt con 
trỏ phóng vào trung tâm vùng cần phóng và ấn phím. Lặp lại cho đến khi đạt tới tỷ 
lệ mong muốn.

Cách hai: Xác định vùng cần phóng trên màn hình. Giữ phím con trỏ và di 
chuyển để xác định một vùng hình chữ nhật trên màn hình. Sau khi nhả phím con 
trỏ, vùng đã được xác định phóng ra đầy cửa sổ. Lặp lại cho đến khi đạt tới tỷ lệ 
mong muốn.

* Thu nhỏ (Zoom out): Chọn con trỏ thu (Zoom out cursor).

Cách một: Tự động thu nhỏ một nửa. Chọn biểu tượng và đặt con trỏ thu 
vào trung tâm vùng cần thu và ấn phím. Lặp lại cho đến khi đạt tới tỷ lệ mong 
muốn.

Cách hai: Xác định vùng cần thu trên màn hình. Giữ phím con trỏ và di 
chuyển để xác định một vùng hình chữ nhật trên màn hình. Sau khi nhả phím con 
trỏ, toàn bộ vùng xem hiện thời được thu về trong hình chữ nhật vừa định nghĩa và 
thu lại các phần xem bên ngoài cho đầy màn hình. Lặp lại cho đến khi đạt tới tỷ lệ 
mong muốn.

* Di chuyển bản đồ: Hai cách

Cách một: Chọn Move tool trên bảng công cụ (Tool Palette). ấn phím con 
tor và di chuyển con trỏ trên màn hình. Toàn bộ bản đồ sẽ di chuyển theo. Khi bản 
đồ trên màn hình đạt tới vị trí mong muốn, nhả phím con trỏ. 

Cách hai: Qua điều khiển các thanh di chuyển (Scroll bar) dọc, ngang của 
cửa sổ hiện thời.

* Thay đổi tỷ lệ xem (Chage View):

Chọn menu MAP (Alt + M)

Chọn menu item Change View (V)

* Thay đổi tỷ lệ xem theo:

- Chiều ngang bản đồ: Chọn Zoom (window width)

- Tỷ lệ bản đồ: Chọn MAP Scale

* Di chuyển bản đồ: 

Xác định lại trung tâm hiển thị bản đồ trên màn hình. Thay đổi lại tâm bản 
đồ qua chọn Center of Window.
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*  Thay đổi  hiển thị  các lớp thông tin,  điều khiển các lớp thông tin 
(Control Lavers)       

- Chọn menu MAP (Alt + M)

- Chọn item menu (layer control) hoặc Ctrl + L

Trên màn hình xuất hiện bảng điều khiển các layer (Layer Control). Toàn 
bộ các lớp thông tin của WORKSPACE được phản ánh trên bảng này. Các thông tin 
về lớp layer trên bảng này là:

Tên

Kiểu hiển thị trên màn hình (Display)

Kiểu hiển thị bình thường như khi vào (Default)

Kiểu hiển thị theo kiểu người dùng tự định nghĩa (Universal)

Kiểu hiện thị theo bảng chú giải (Shading)

Người dùng có thể sửa (về mặt dữ liệu không gian) hay không (Editable)

Có  cho  phép  được  tham  gia  vào  trong  các  câu  hỏi  đáp  hay  không 
(Seletable)

Có đặt một phạm vị giới hạn tỷ lệ cho hiển thị hay không  (Zoom Layered)

* Các chức năng có thể thực hiện cho các lớp trong bảng:

Thay đổi hiển thị cho lớp hiện tại đang được chọn trên bảng. Chọn phím 
Settings (được mô tả cụ thể ở dưới).

Thêm bớt đi các lớp thông tin hiện có trong WORKSPACE.

Remove: Xóa đi lớp thông tin hiện tại đang được chọn trên bảng 

Add: Thêm lớp thông tin mới

Thay đổi thứ tự hiển thị các lớp thông tin (Rcorder)

Các lớp thông tin được hiển thị dưới lên theo thứ tự trong bảng. Để thay đổi 
thứ tự các lớp hiện tại từ dưới lên theo thứ tự trong bảng. Để thay đổi thứ tự của lớp 
hiện tại, chọn Up: đưa lớp lên trên các lớp khác, chọn Down đưa lớp xuống dưới 
các lớp khác.

Chọn Cancel: Huỷ bỏ mọi thay đổi mà người dùng vừa làm trên bảng điều 
khiển lớp thông tin.

Chọn OK: Để chương trình hiển thị dữ liệu thao cách người dùng vừa định 
nghĩa lại.
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* Đặt tham số hiển thị cho một lớp (Laver Settings)

Chon Display trong bảng điều khiển lớp thông tin (Layer Control). Trên 
màn hình xuất hiện các tham số có thể thay đổi được cho lớp hiện tại.

* Thay đổi chế độ hiển thị: (Display Mode)

Chế độ hiển thị:

Tắt: (Off) không hiển thị lớp thông tin trên màn hình.

Bình thường: (Default) hiển thị lớp thông tin theo chuẩn khi vào.

Tự định nghĩa: (Universal) hiển thị lớp thông tin theo cách người dùng định 
nghĩa. Thay đổi qua cách chọn trên Universal Display. 

Kích vào ô tương ứng bên dưới Style Oversal để:

Thay đổi cho các đối tượng kiểu đường trong lớp có thể thay đổi kiểu style, 
màu (color) và kích cỡ (size)          

Thay đổi cho các đối tượng kiểu điểm trong lớp có thể thay đổi kiểu tô 
vùng (pattem mặt trên và nền), màu color.

Thay đổi cho các đối tượng kiểu chữ (font), màu (color), kích thước (size) 
và góc nghiêng (angle) (tính theo độ từ 0 đến 360)

Theo bảng chú giải: (Thematic map) hiển thị theo một hệ thống màu, kiểu 
cho trước nào đó được thể hiển dưới dạng bảng chú giải.

 *  Đặt cho phép người  dùng có quyền sửa dữ liệu hay không (Edit 
Control)

Đánh dấu Editable: cho phép sửa

Đánh dấu Selectable: Có cho phép được tham gia vào trong các câu hỏi đáp 
hay không.

* Giới hạn tỷ lệ hiện thị: (Zoom Lavering)

Đánh dấu chỉ cho phép được hiển thị trong một khoảng nhất định (Display 
when in range).

Nếu đã đánh dấu chỉ cho phép được hiển thị trong một khoảng nhất định 
vào khoảng giới hạn tỷ lệ. Cận trên (Min Zoom) cận dưới (Max Zoom)

* Đặt cách thể hiển nhãn của các đối tượng trong lớp (LABLE)  

Mỗi một đối tượng có hai dữ liệu: dữ liệu không gian đang hiển thị trên 
màn hình và dữ liệu phi không gian lưu dưới dạng bảng thuộc tính hàng cột. Trên 
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màn hình hiển thị dữ liệu không gian, gắn với mỗi một đối tượng, có một nhãn thể 
hiện một số liệu nào đó về thuộc tính của đối tượng đó.

Cách tạo ra xin xem phần 4.1 tra cứu thông tin theo vị trí địa lý:

* Quyết định thuộc tính nào sẽ được làm nhãn của các đối tượng

Chọn một cột trong bảng thuộc tính của lớp "Lable with columns" hoặc một 
biểu thức Expression do người dùng tự định nghĩa.

Nhãn được thể hiện bằng một dòng chữ gắn đối tượng được đánh nhãn. 
Nhãn có thể liên hệ với đối tượng tương ứng qua một đường thẳng (có/không có 
mũi tên) chỉ tới đối tượng.

4. Tra cứu thông tin 

4.1. Tra cứu thông tin theo vị trí địa lý

Trả lời cho câu hỏi "cái gì tại vị trí (vùng) không gian này".

Phương pháp: chọn các đối tượng không gian tại một vị trí hay một vùng 
không gian nào đó và xem các thông tin của đối tượng này.

a. Công cụ lấy thông tin không gian của một đối tượng được chỉ ra trên  
màn hình (Selact Tool)

Chọn công cụ hình mũi tên trong bảng các công cụ (Tools). Người dùng 
muốn tra cứu thông tin về một đối tượng nào đó, dùng con trỏ kích hai lần vào đối 
tượng (double click).

Các thông tin người dùng có thể có được:

Đối tượng kiểu điểm (POINT): toạ độ điểm

Đối  tượng  kiểu  đường  (LINE):  vùng  khống  chế  (bounds),  chiều  dài 
(length), điểm trung tâm (Center) số đoạn (Line segments).

Đối  tượng  kiểu  vùng  (POLYGON):  vùng  khống  chế  (bounds),  chu  vi 
(primeter) (Line segments), diện tích (Area), điểm trung tâm (Center) số đoạn (Line 
segements) số vòng (Polygon).

Đối tượng kiểu chứ (TEXT): nội dung chữ, kiểu (font), điểm bắt đầu (start), 
góc quay (Rotation angle).

b. Công cụ lấy thông tin phi không gian tương ứng với đối tượng cần tra  
cứu (info Tool):

Chọn công cụ có chữ I (Info) trong bảng các công cụ (Tools). Người dùng 
muốn tra cứu thông tin phi không gian về một đối tượng nào đó, dùng con trỏ kích 
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hai lần vào đối tượng (double click). Trên màn hình xuất hiện cửa sổ thông tin (info 
window) để hiển thị thông tin phi không gian tương ứng với đối tượng được kích. 
Thay đổi đối tượng, số liệu trên cửa số thông tin thay đổi theo.

c. Công cụ tìm thông tin của một hay một nhóm các đối tượng theo một  
vùng nào đó (Search by region)

* Tìm theo một bán kính (Radius search selector tool):

Chọn công cụ có hình mũi tên chỉ vào một vòng tròn trong bảng các công 
cụ (Tools)

Đưa con trỏ vào tầm vùng cần tìm

Giữ phím con trỏ và xác định bán kính vùng cần xem (được mô tả bằng một 
vòng tròn trên màn hình). Tất cả các đối tượng nằm trong vùng này được xác định 
như là các đối tượng được chọn. Trên cửa sổ bản đồ (map) các đối tượng thoả mãn 
đổi màu và khí người dùng mở bảng dữ liệu phi không gian (browse) thì các bản ghi 
chữa các dữ liệu tương ứng cùng đổi màu.

* Tìm các đối tượng không gian trong một vùng do người dùng từ định 
nghĩa (polygon Search Seletor Tool):

Chọn công cụ có hình mũi tên chỉ vào một hình vẽ tượng trưng vùng trong 
bảng các công cụ (Tools).

Người dùng con trỏ vẽ vùng cần tìm kiếm theo một hình dạng bất kỳ.

Kết thúc vùng ấn phím con trỏ hai lần. MAPINFO tự đóng kín và chọn tất 
các đối tượng nằm trong vùng. Tất cả các đối tượng nằm trong vùng này được xác 
định như là các đối tượng được chọn. Trên cửa sổ bản đồ (map) các đối tượng thoả 
mãn đổi màu và khi người dùng mở bằng dữ liệu phi không gian (browse) thì các 
bản ghi chứa các dữ liệu tương ứng cùng đổi màu. 

4.2. Tra cứu thông tin theo thuộc tính       

Trả lời  câu hỏi "những đối tượng nào, ở đâu thoả mãn điều kiện này". 
Phương pháp chỉ ra các đối tượng không gian trên bản đồ thoả mãn một hay nhiều 
điều kiện nào đó theo dữ liệu phi không gian.

Có hai cách hỏi đáp cho dạng này.

Hỏi theo biểu thức thông thường (Select)

Hỏi theo dạng ngôn ngữ hỏi đáp cấu trúc cho mô hình cơ sở dữ liệu quan hệ 
(SQL Structure Query Language) (SQL Select)

a. Hỏi theo biểu thức thông thường (Select)
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  Chọn item menu "SELECT" trong menu "ANALYSE": Cho phép người 
dùng chọn các bản ghi và các đối tượng từ một bảng theo các thuộc tính của các đối 
tượng. Các bản ghi trong bảng dữ liệu phi  không gian và các đối tượng trên bản đồ 
mà thoả mãn điều kiện lựa chọn sẽ được chỉ ra. Người dùng có thể tạo ra một bảng 
kết quả và rồi có thể xem dữ liệu phi không gian (browse) và hiển thị dữ liệu không 
gian (map) như các bảng khác.

Khi chọn select trên màn hình xuất hiện cửa sổ đối thoại "Select Window". 
Chọn bảng đối tượng mà người dùng muốn tìm kiếm: "Select records from table" 
xây dựng biểu thức tìm kiếm: "That satisfy"

Kết quả được ghi ra bảng mới với tên khai trong "Store result in table". Nếu 
không các kết quả tìm kiếm được ghi lại dưới bảng có tên lần lượt là "Query1", 
"Query2",…

Kết quả được xắp xếp theo thứ tự tăng hoặc giảm dần theo giá trị trường 
khai trong "Sort result by column". 

Để kất quả được hiển thị ra dưới dạng bảng trên màn hình, đánh dấu trong 
"Browse results". Chọn "OK" để thực hiện tìm kiếm.

Khi người dùng cần có sự trợ giúp trong quá trình xây dựng biểu thức tìm 
kiếm, chọn "assist…"    

b. Hỏi đáp theo SQL (SQL Select)

Chọn menu item "SQL Select" trong menu "Analyse"

SQL Select cho phép người dùng tạo hỏi đáp tổng hợp trên một hay nhiều 
bảng. SQL Select là một trong các câu lệnh mạnh nhất của MAPINFO.

SQL select cho phép người thực hiện các công việc sau:

Tạo các thông tin dẫn suất (Derived Information)

Kết nối các bảng dữ liệu (Joining)

Thu thập dữ liệu (Assembly)

Thông tin dẫn suất (Derived Information) là các thông tin có thể tính được 
từ các bảng dữ liệu mà không được thể hiện tường minh trong các bảng này.

SQL select cho phép người dùng lấy từ ra từ thông tin từ một hay nhiều 
bảng dữ liệu tạo ra một bangr mới chứa các thông tin dẫn xuất.

Kết nối: (Joining)

Cơ bản, thông tin được lưu trong nhiều bảng dữ liệu riêng biệt nhau. SQL 
select cho phép người dùng tạo các quan hệ kết nối để người dùng có thể đưa các 
thông tin từ các bảng dữ liệu khác nhau vào bản đồ của người dùng. 
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Thu thập: (Assembly): thu thập có nghĩa là người dùng tạo ra một bảng mới 
qua thu thập dữ liệu rõ ràng hay các dữ liệu dẫn xuất từ các bảng đã tồn tại.

Cụ thể hơn về cách tạo ra câu hỏi đáp kiểu SQL (ngữ pháp) xin xem thêm 
các sách giới thiệu về cơ sở dữ liệu quan hệ và ngôn ngữ hỏi đáp SQL.

Cú pháp tổng quát của SQL select trong MAPINFO như sau:

Select <một hoặc nhiều cột> from <một hoặc nhiều bảng> Where <điều 
kiện cần thoả mãn>

MAPINFO cung cấp một số hàm cho SQL như sau:

Count(*) đếm số bản ghi trong bảng thoả mãn điều kiện.

Sum(<biểu thức>)        : tính tổng

Average (<biểu thức>): tính trung bình

Max(<biểu thức>)       : tính giá trị lớn nhất

Max(<biểu thức>)       : tính giá trị nhỏ nhất

Sau đây là một số toán tử không gian của SQL cho dạng dữ liệu không gian: 
Các toán tử không gian cho phép người dùng chọn ra các đối tượng dựa trên các 
mối  quan hệ  về  không gian  với  các  đối  tượng khác.  MAPINFO dùng từ  khoá 
(keyword) dùng với các toán tử không gian là  "ojb" hoặc "oject".  Từ khoá này 
thông báo cho MAPINFO biết lấy giá trị từ các đối tượng không gian chứ không lấy 
từ các bảng dữ liệu.

Sau đây là các toán tử không gian của MAPINFO dùng trong SQL Seclect:

" Contains" chứa: đối tượng A chứa đối tượng B nếu điểm trọng tâm của B 
ở bất cứ nơi nào trong A.

"Contain Entire" chứa toàn bộ: đối tượng A chứa toàn bộ đối tượng B nếu 
toàn bộ đường bao của đối tượng B nằm trong đối tượng A.

"Within" trong: A trong B nếu trọng tâm A là trong đường bao của A

"Entirely Within" trong toàn bộ: A trong toàn bộ B nếu toàn bộ đường bao 
của A đều trong đường bao của B.

"Itersects" cắt: A cắt B nếu chúng có ít nhất một điểm chung hoặc nếu một 
trong hai đối tượng trong toàn bộ đối tượng khác.

4.3. Tạo biểu đồ (GRAPH)

Chọn menu item "Graph" trong menu "Window"

Cho phép người dùng chọn số liệu trong một bảng tạo ra một biểu đồ hai 
chiều XY.
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Chiều X: là một cột bào đó trong bảng. Kiểu số liệu của cột này có thể là 
số, chữ vv...

Chiều Y: tối đa là 4 cột. Kiểu số liệu của các cột này phải là số.

Trên màn hình xuất hiện cửa sổ đối thoại để tạo bảng biểu đồ (Graph Table)

Graph Table: Chọn bảng để vẽ biểu đồ

Using columns: chọn các cột vẽ biểu đồ. Tối đa là 4 cột.

Lable with column: chọn cột làm giá trị cho chiều X

Để vẽ biểu đồ chọn menu Item Graph type trong menu GRAPH

Graph Title: tiêu đề của biểu đồ. Người dùng có thể thay đổi nội dung, kiểu, 
kích thước tiêu đề.

* Chọn kiểu biểu đồ Graph Type

Area: biểu đồ dưới dạng theo diện tích

Bar: biểu đồ dưới dạng thanh hộp

Line: biểu dồ dưới dạng đường

Pie: biểu đồ dưới dạng hình tròn phần trăm

XY: biểu đồ dưới dạng điểm.

* Option các lựa chọn khác

Stacked: chồng lên nhau

Overlaped: phủ lên nhau

Drop Lines: có vẽ thêm các đoạn thẳng từ đỉnh cao nhất tới trục X

Rotated: quay ngang biểu đồ

Show 3D: hiển thị dưới mô hình 3 chiều

Overlap %: tỷ lệ phần trăm các thanh phủ lên nhau. 0% không phủ lên 
nhau. 100% phủ nhau hoàn toàn.

Bar Gutter %: tỷ lệ khoảng cách  giữa các thanh so với độ đầy các thanh.

Start Pie Angle: góc bắt đầu vẽ cho loại biểu đồ Pie. Chuẩn là góc = 0.

4.4. Tạo các bản đồ chuyên đề (THEMATIC MAP) từ trường dữ liệu (Create  
Thematic map)

a. Kiểu bản đồ phân bậc độ giải (Range Map)

Kiểu chung nhất của các bản đồ chuyên đề (thematic map) là bản đồ được 
phân loại theo một số các khoảng giá trị khác nhau. Tất cả các đối tượng rơi vào 
cùng một khoảng được phản ánh trên bản đồ theo cùng một kiểu. Ví dụ như cùng 
loại ký hiệu (symbol), cùng kiểu đường, cùng màu vv..
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Ví dụ bản đồ đề dân số theo xã của một huyện, người dùng có thể chia các 
vùng trên bản đồ theo mật độ dân số như:

Ví dụ bản đồ chủ đề dân số theo xã của một huyện, người dùng có thể chia 
các vùng trên bản đồ theo mật độ dân số như:

Khoảng 1: nhỏ hơn 100 người/1km2

Khoảng 2: từ 100 đến 500 người/1 km2

Khoảng 3: từ 501 đến 2000 người/km2

b. Kiểu bản đồ theo các giá trị đơn (Individual Values)

Các đối tượng trên bản đồ được tự động chia khoảng theo từng gía trị đơn 
của các đối tượng.

c. Kiểu bản đồ theo mật độ điểm (Dots densitv):

Trong kiểu bản đồ theo mật độ điểm, các điểm được dùng để phản ánh một 
số lượng các gía trị. Ví dụ tạo bản đồ dân số theo kiểu mật độ điểm, một điểm tương 
ứng với 10 người. Vùng có 300 người được thể hiện bằng 30 điểm, vùng 2000 thể 
hiện bằng 200 điểm.

Các điểm được phân bố ngẫu nhiên trong một vùng. Số lượng điểm trong 
vùng phản ánh giá trị tương ứng của vùng đó.

d. Biểu đồ bản đồ (Graduated Symbol)

Biểu diễn theo kiểu này, kích thước của symbol được tạo ra tương ứng với 
giá trị mà nó thể hiện. Các giá trị không được chia thành nhóm theo khoảng, chỉ có 
kích thước ký hiệu thay đổi liên tục theo giá trị. Một symbol lớn thể hiện một giá trị 
cao, symbol nhỏ thể hiện giá trị bé. Biểu đồ ở đây có thể phân chia cấu trúc hoặc 
không.

e. Cách tạo một bản đồ chủ đề trong MAPINFO

Đối tượng mà người dùng định thể hiện trên bản đồ chuyên đề được gọi là 
biến chủ đề (thematic variable). Để tạo một bản đồ chủ đề, người dùng cần biết:

Biến chủ đề nào.

Dữ liệu dùng để tạo chủ đề lấy từ bảng nào, cột nào trong bảng.

Thể hiện bản đồ bằng phương pháp nào.

Vào tạo bản đồ chủ đề từ menu Map chọn Create Thematic Map 

Xác định phương pháp biểu thị yếu tố nội dung (biểu đồ, đồ giải, điểm hay 
vùng...), nhấn phím Next để đến bước tiếp theo.

Chỉ định tên table bào sẽ sử dụng để thành lập bản đồ.
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Chọn cột dữ liệu (Field) để MAPINFO lấy các giá trị trong browser xây 
dựng bản đồ. Nhấn phím Next để chuyển đến bước tiếp theo.

Chọn OK: MAPINFO tạo bản đồ chuyên đề theo phương pháp bản đồ mà 
người dùng đã ấn định, màu sắc do MAPINFO tự xác định.

MAPINFO cho phép người dùng có thể can thiệp khá sâu vào quá trình 
thành lập bản đồ cũng như đặt lại kiểu hiển thị các yếu tố nội dung trên bản đồ 
chuyên đề. Với phương pháp đồ giải người dùng có thể định lại số lượng bậc trên 
bản đồ (2,4,6,8...bậc), có thể lựa chọn các kiểu biểu đồ khác nhau khi dùng phương 
pháp biểu đồ, đặt lại màu sắc hiển thị yếu tố nội dung sau khi tạo bản đồ cho phù 
hợp với quy phạm thành lập bản đồ...

3. Cập nhật dữ liệu và sửa đổi dữ liệu (UPDATE)

3.1. Cập nhật và sửa đổi dữ liệu thuộc tính

Cách sửa chữa dữ liệu thuộc tính dễ dàng nhất và trực quan nhất là sửa trên 
cửa sổ BROWSER.

Để có thể tự động sửa chữa một hoặc nhiều các đối tượng cùng một lúc, 
dùng lệnh UPDATE COLUMN trong menu TABLE. Lệnh cho phép sửa một thuộc 
tính nào đó của toàn bộ các đối tượng trong bảng hoặc một số các đối tượng đã 
được chỉ ra trước.

3.2. Sửa chữa p0hần dữ liệu không gian

Dữ liệu không gian được lưu trong cửa sổ MAP. Một MAP có thể chứa một 
hoặc nhiều các layer khác nhau. Để sửa chữa một lớp nào đó, dùng lệnh LAYER 
CONTROL trong menu MAP chọn layer cần sửa, bật chọn lựa EDITTABLE, tiếp 
theo chọn OK.

Layer có lựa chọn EDITTABLE có khả năng sửa chữa bằng các công cụ vẽ 
(xem phần trên). Trong trường hợp trong một cửa sổ MAP có nhiều layer khac 
nhau, để xác định đối tượng cần sửa thuộc layer nào, dùng công cụ info (phím có 
chữ I) trong bảng công cụ chính.

4. In ấn

4.1. Giai đoạn chuẩn bị bản đồ để in ra (LAYOUT)

Dữ liệu được in ra dưới dạng các cửa sổ

Có 3 loại cửa sổ:

Cửa sổ dữ liệu không gian: cửa sổ cho WORKSPACE hay các cửa sổ chữa 
các kết quả hỏi đáp, tìm kiếm.
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Cửa sổ cho dữ liệu phi không gian: cửa sổ BROWSE cho các lớp dữ liệu 
hay các cửa sổ chứa các kết quả hỏi đáp, tìm kiếm. (Cửa sổ QUERY).

Cửa sổ chứa các đồ thị, biểu đồ được vẽ lên từ dữ liệu (Cửa sổ GRAPH).

Cùng một lúc, người dùng có thể in một hay nhiều các cửa sổ trong ba loại 
cửa sổ trên.

LAYOUT là công việc bố trí các cửa sổ sẽ được in ra trên giấy như thế nào. 
Sau khi người dùng ưng ý với LAYOUT hiện tại thì mới đưa bản đồ cần in trên 
LAYOUT ra máy in.

4.2. Tạo LAYOUT

Chọn menu LAYOUT từ menu WINDOWS.  Nếu không có cửa sổ nào 
được mở, xuất hiện một cửa sổ trống cho layout. Nếu tồn tại một hay nhiều cửa sổ 
xuất hiện cửa sổ hội thoại tạo ra một layout mới (New Layout Window).

Chọn "One Frame for Window": Khi người dùng muốn đưa vào Layout chỉ 
một cửa sổ mà thôi.

Chọn "Frame for all currently windows": Khi cửa sổ muốn đưa toàn bộ các 
cửa sổ đang mở (bản đồ, bảng số liệu, đồ thị, kết quả hỏi đáp.v.v.) vào layout.

Chọn "No Frames": Khi người dùng tạo ra một layout trống.

Khi tạo raoio cửa sổ layout, kích thước cửa sổ layout phụ thuộc vào kích 
thước (Sizze) và hướng (orientation) giấy của thiết bị in ra hiện tại. Cách để thay 
đổi kích thước layout, xin xem tiếp dưới.

Thao tác xem cửa sổ layout như thao tác với một cửa sổ bản đồ thông 
thường co dãn, thay đổi tỷ lệ xem, thay6 đổi vùng xem v.v.

4.3. Thay đổi kích thước LAYOUT

Thay đổi kích thước vật lý và hướng của thiết bị máy in. Ví dụ như HP 
Deskjet sang HP Paintjet chọn PRINTERSETUP và chuyển máy in hiện tại (current 
printer) từ HP Deskjet sang HP Paintjet. Khi kích thước này thay đổi thì kích thước 
cửa sổ layout cũng thay đổi theo.

Thay đổi số lượng trang và độ rộng lề giấy:

Chọn menu item "Layout size" trong menu "layout"

Thay đổi số lượng giấy theo chiều ngang: đặt lại width

Thay đổi số lượng giấy theo chiều dọc: đặt lại height

Thay đổi lại kích thước lề giấy: đặt lại "Margin"
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4.4. Thay đổi kích thước các cửa sổ được in ra trong layout

Các cửa sổ bản đồ và các bảng chú giải đi kèm với nó (nếu có)

Bằng tay: dùng con trỏ kéo dãn vùng cần in

Qua tỷ lệ: Kích phím con trỏ kéo dãn vùng cần in ra như toạ độ tâm, tỷ lệ 
(km/cm). Các tham số này được người dùng chọn sao cho đạt hiệu quả mong muốn. 
Các cửa sổ khác thao tác chủ yếu bằng tay.

4.5. In nội dung layout ra thiết bị

Chọn đúng thiết bị in máy in hoặc máy vẽ.

Bật thiết bị in

Kiểm tra cáp truyền dữ liệu đã được nối thích hợp giữa máy tính và thiết bị 
in.

Kiểm tra giấy in, một số thiết bị in, khi in sẽ tự động nạp giấy ví dụ như 
máy in. Còn một số thiết bị ví dụ như máy vẽ có thể chúng ta phải nạp giấy bằng tay 
trước khi in bản đồ ra.

Để in nội dung LAYOUT, lựa chọn PRINT trong menu FILE. Trong một số 
trường hợp nếu bộ nhớ trong (RAM) của thiết bị ra không chứa đủ dữ liệu đưa từ 
máy tính, bản in có thể không hoàn thành được. Cách khắc phục tôt nhất là tăng 
thêm bộ nhớ trong cho thiết bị ra.

Hướng dẫn sử dụng phần mềm mapinfo
để biên tập bản đồ

I. Các lệnh trên menu
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I.1 File menu.

1.1. New table (bảng mới) : cho phép tạo một bảng mới.
1.2. Open Table (mở bảng): cho phép mở một bảng của Mapinfo. Dữ liệu file DBF 
của dBASE. File dữ liệu ASCII,  dữ liệu của lotus 1-2-3,  dữ liệu của bảng tính 
Micicrrosoft  Excel.
 Open Workspace (mở Workspace): cho phép mở Workspace.
1.3. Close table (đóng bảng 0 cho phép đóng bảng, kể cả các bảng hỏi đáp (Query).
1.4. Close all (đóng tất các bảng). Cho phép đóng tất cả các bảng đã được mở.
1.5. Save table (ghi bảng): cho phép ghi lại bảng cùng những sự thay đổi trước đó.
1.6. Save copy as (ghi bảng sang tên khác 0 cho phép ghi bảng sang tên khác.
1.7. Revert table (lấy lại bảng trước khi đã thay đổi): Cho phép trở lại đến bảng 
trước đó khi thực hiện thay đổi đến đó.
1.8. Save Workspace (ghi Workspace) cho phép ghi lại thông tin xung quanh những 
bảng và những cửa sổ đã được sử dụng trong đoạn hiện thời của bảng.
1.9.  Run  Mapbasic  program (chạy  chương  trình  Mapbasic)  cho  phép  chạy  các 
chương trình viết bằng Mapbasic cho Mapinfo.
1.10. Print (in): Cho phép bạn in nội dung của cửa sổ Layout, Browser, Graph.... ra 
máy in và dảm bảo các chế độ như dã đặt như trong Print setup.
1.11. Print setup (đặt máy in): Cho phép chọn máy in và các thông số cho máy in. 
chọn kích cỡ giấy kiểu đặt giấy (ngang / dọc).
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 1.12. Save window as (ghi cửa sổ bản đồ sang dạng khác). Cho phép bạn để lưu giữ 
cửa sổ làm việc và ghi nó như file ảnh bitmap (BMP) hoặc như một cửa sổ.
1.13. Exit (thoát): Cho phép thoát khỏi chương trình Mapinfo.

I.2. Edit menu.

2.1. Undo (trở lại): Cho phép bạn loại bỏ hành động vừa được biên tập.
2.2. Cut (cắt): Cho phép loại bỏ các Text và các đối tượng đã được lựa chọn và 
chuyển chúng vào Clipboard.
2.3.  Copy (sao chép) :  Cho phép sao chép Text hoặc các thông tin đồ hoạ vào 
Clipboard.
2.4. Paste (dán) : Cho phép sao chép nội dung của Clipboard vào bảng hoặc cửa sổ 
đang biên tập.
2.5. Clear (xoá): Cho phép xoá Text hoặc các đối tượng đã được chọn.
2.6. Clear map Objects (xoá đối tượng bản đồ): Cho phép bạn bỏ những đối tượng 
đồ hoạ từ bảng.
2.7. Reshape (định dạng lại): Cho phép chốt dữ liệu vào hoặc ra của kiểu định dạng. 
Sử dụng để bien tập vùng (Region), đường khép kín (polylines), đường (lines) và 
những điểm bởi sự dịch chuyển thêm, xoá những nút tại định nghĩa đoạn dường. 
Bạn có thể cũng sao chép và dán.
2.8.  New Row (hàng mới):  cho phép thêm một bản ghi trống tại  chỗ cuối  của 
Browser hoạt động. New Row hoạt động khi : Một Browser đang hoạt động và cho 
phép biên tập bảng là mở. Bạn không thể biên tập bảng có thuộc tính chỉ đọc như 
bảng ASCI Excel và Lotus.
2.9. Get Info (nhận thông tin): Cho phép bạn hiển thị hộp hội thoại thuộc tính đối 
tượng (Object Attribute dialog) biên tập hoặc chỉ đọc cho đối tượng đã được chọn 
trong Map hoặc Layout để thay thế thuộc hai lần bấm trên đối tượng. Sử dụng hộp 
thoại này để chỉ rõ thuộc tính bản đồ cho một đối tượng. Get Info hoạt dộng khi một 
cửa sổ bản đồ (Map Window) hoặc là một Layout đang hoạt động và một đối tượng 
đã được chọn.
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I.3. Object menu.

3.1. Set Target (đặt mục tiêu): Cho phép bạn cho chuẩn bị một đối tượng được chọn 
để chấp thuận thủ tục biên tập tiếp theo (Combine, Erase, Erase Outside, Split and 
Overlay Nodes). Set Target được hoạt động khi một cửa sổ bản đồ được hoạt động 
(Map Windows) và một lớp thông tin trong cửa sổ bản đồ hiện thời là được phép 
biên tập và ít nhất có một đối tượng trong lớp thông tin đó được chọn.
3.2. Clear Target (xoá mục tiêu): Cho phép bạn xoá các đối tượng được sử dụng Set 
Target. Clear Target hoạt động khi một cửa sổ bản đồ được hoạt động, đã tồn tại 
một đối tượng đã sử dụng Set Target và Combine, Erase, Erase Outside, Split and 
Overlay Nodes không có chứa đựng ngoài trên đối tượng.

10.3 Series (số hiệu đồ thị) Cho phép bạn tuỳ thuộc vào số hiệu yếu tố trong biểu 
đồ, đồ thị. Series hoạt động khi có một cửa sổ đồ thị hoạt động.
10.4 Value Axis (giá trị trục) bạn có thể thay đổi những nhãn những đường lưới của 
giá trị trục. Value Axis hoạt động có khi có một cửa sổ đồ thị hoạt động.
I.11. Layout 
11.1. Align Objects (Xếp thẳng hàng đối tượng) cho phép bạn sắp xếp đối tượng 
cùng đối tượng khác trong Layout, hoặc cùng cửa sổ layout mà nó tự tạo ra. Align 
objects hoạt động khi: Có một cửa sổ Layout hoạt động cửa sổ và đối tượng đã 
được chọn trong layout.
11.2. Bring To Front (đưa ra trước) Cho phép bạn đưa đối tượng ra từ đối tượng sau 
biến đổi nó trong layout. Bring to Front hoạt động khi: Có một vàI đối tượng layout 
đã được chọn.
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11.3. Change Zoom (thay đổi độ thu phóng) Cho phép bạn hiển thị hộp hội thoại để 
bạn thay đổi độ thu phóng của layout hiện thời đang hiển thị. Change Zoom hoạt 
động khi: có một cửa sổ layout hoạt động.
11.4. Create Drop Shadows (tạo bảng) Cho phép bạn tạo phóng đằng sau khung cửa 
sổ hoặc đối tượng trong layout. Create Drop Shadows hoạt động khi: có một cửa sổ 
layout hoạt động và một đối tượng layout được chọn.
11.5. Options (các lựa chọn) Cho phép bạn chỉ ra khu cửa sổ và nội dung của nó 
được hiển thị trong cửa sổ layout và cửa sổ layout nào  được hiển thị. Nó cũng cho 
phép bạn chỉ ra giới hạn và số lượng của giấy cho layout hiện thời. Options hoạt 
động khi: có một cửa sổ layout hoạt động.
11.6. Send to Back (chuyển đến phía sau) Cho phép bạn thay đổi thứ tự đối tượng 
trong layout theo vị trí được chọn hiện thời. Send to Back hoạt động khi: Có một 
cửa sổ layout hoạt động và một đối tượng được chọn.
11.7. Previous View (trở lại lần xem trước) Cho phép bạn trở lại để trực tiếp lần 
xem trước. Previous View hoạt động khi: có một cửa sổ bản đồ hoặc cửa sổ layout 
hoạt động. Cửa xem trước đã được thay đổi.
11.8. View Actual Size (xem độ lớn thực) Cho phép bạn hiển thị layout cũng ở đấy 
các đối tượng xuất hiện độ lớn thực của nó. Độ lớn thực của đối tượng là độ lớn của 
đối tượng đó khi in. View Actual Size hoạt động khi: có một cửa sổ layout hoạt 
động.
11.9. View Entire Layout (xen toàn bộ layout) xem trong menu Map nhưng thay vì 
Map thì ở đây là layout.
I.12. Redistrict (chia lại vùng).
12.1. Add District: Sử dụng lệnh này để thêm một vùng mới đến một vùng đã có 
Redistrict hoạt động khi: có một lần chia lại vùng có kết quả.
12.2. Assign Selected Objects (ấn định đối tượng được chọn) Sử dụng lệnh này để 
cố định tất cả các đối tượng bản đồ được chọn để làm mục tiêu cho chia vùng. 
Assign Selected Objects hoạt động khi: có một lần chia lại vùng có kết quả và có 
một hoặc hơn một đối tượng bản đồ được chọn.
12.3. Delete Target District (xoá đối tượng mục tiêu để chia vùng): sử dụng lệnh 
này để xoá đối tượng mục tiêu để chia vùng hiện thời. Delete Target District hoạt 
động khi: có một lần chia lại vùng có kết quả.
12.4. Options (các lựa chọn) Sử dụng lệnh này cho phép bạn vào hộp hội thoại lựa 
chọn chia lại vùng Redistricter Options. Hộp hội thoại này cho phép bạn chỉ ra thứ 
tự của hiển thị chia vùng và đường lưới. Options hoạt động khi: Có một lần chia lại 
vùng có kết quả.
12.5. Set Target District from Map (đặt mục tiêu từ bản đồ) Sử dụng lệnh này để 
những đối  tượng được chọn làm mục tiêu cho việc  chia  vùng mới.  Set  Target 
District from Map hoạt động khi: có một lần chia lại vùng có kết quả và một đối 
tượng bản đồ đã được chọn.
I.13. MapBasic
13.1. Clear Contents (xoá nội dung) Sử dụng lệnh này để xoá nội dung của sửa sổ 
biên tập MapBasic hoạt động mà không cho phép nó vào Cliboasd.
13.2. Save Contents (ghi nội dung) Sử dụng lệnh này để ghi nội dung của cửa sổ 
biên tập MapBasic hoạt động tới đĩa.
II. Các nút trên thanh công cụ.
II.1.Main buttomPad (nút trên thanh công cụ chính).
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1.1. Assign Selected Objects (ấn định đối tượng được chọn) xem ở mục I.12.2 (hình 
ngoằn ngoèo không nền).
1.2. Boundary Select (chọn đường bao) Cho phép bạn vào công cụ chọn đường bao. 
Công cụ chọn đường bao để tìm và chon tất cả các đối tượng ở phía trong của vùng 
(vùng có mũi tên).
Change View (thay đổi quan sát) xem 9.1 (kính có dấu hỏi)
1.4. Grabber (thay đổi vị trí xem)Cho phép bạ thay đổi lại vị trí của bản đồ hoặc 
layout ở trong cửa sổ của nó (bàn tay).
1.5. Info Sử dụng để chọn vị trí trên bản đồ của bạn bao gồm một số đối tượng đè 
lên nhau và hiển thị một liệt kê của tất cả các đối tượng tại vị trí đó (chữ I)
1.6. Label Sử dụng để đặt nhãn đối tượng cùng thông tin từ liên kết đối tượng cơ sở 
dữ liệu (có nhãn).
1.7. Layout Cotrol (đIều khiển lớp thông tin) xem ở I.9.6 (xếp lớp)
1.8. Show/Hide Legend Window (Hiện / ẩn cửa sổ chú giải) xem ở I.6.7 (có các 
dòng chữ)
1.9. Marquee Select Chọ đối tượng trong một vùng chữ nhật (hình chữ nhật có mũi 
tên)
1.10. Radius Select Chọn đối tượng trong một vòng tròn (hình tròn có  mũi tên)
1.11 Ruler cho phép bạn đo khoảng cách giữa hai điểm (có thước)
1.12. Select Sử dụng để chọn một hoặc nhiều đối tượng hoặc bản ghi để phân tích. 
Bạn có thể chọn nhiều đối tượng bằng cách giữ phím Shift và bấm vào đối tượng 
(mũi tên)
1.13. Set Target District from map (đặt mục tiêu từ bản đồ) xem I.12.5 (hình ngoằn 
nghèo có nền).
1.14. Statistics (thống kê) Sử dụng để hiển thị cửa sổ thống kê. cửa sổ thống kê 
kiểm tra tổng và trung bình của tất cả các trường số cho đối tượng / bản ghi hiện 
thời được chọn (có dấu tổng)
1.15. Zoom-in Sử dụng để thu nhỏ một vùng kín của bản đồ hoặc layout (kính có 
dấu +)
1.16. Zoom-out Sử dụng để phóng to một vùng kín của bản đồ hoặc layout (kính có 
dấu -)
II.2. Drawing buttomPad
2.1. Add Node (thêm nút) Sử dụng để thêm nút đến các đối tượng như vùng, đường 
bao, đường cong (dấu + có mô tả nút).
2.2. Arc Sử dụng để vẽ đường cong (có cung cong).
2.3. Ellipse sử dụng để vẽ hình Ellipse (vẽ hình tròn khi giữ phím Shift)
2.4. Frame cho phép bạn tạo khùn trong layout. Mỗi khung càn phải hiển thị một 
bản đồ, đồ thị, dữ liệu, chú giải bản đồ, cửa sổ thông tin, cửa sổ thống kê, cửa sổ 
thông báo.(hình vuông màu vàng)
2.5. Line: Sử dụng để vẽ đường thẳng nếu bạn giữ phím Shift thì có thể vẽ thẳng 
theo các hướng nguyên lần của 45 độ.
2.6. Line Style (kiểu đường) xem 1.6.4.
2.7. Polygon: Sử dụng các đường bao kín.
2.8. Polyline: Sử dụng để vẽ nhiều đoạn thẳng liên tiếp.
2.9.Rectangle: Sử dụng để vẽ hình chữ nhật nếu giử phím Shift thì vẽ hình vuông.
2.10.Region Style (kiểu vùng) xem ở i.6.5
2.11.  Reshape (thay  đổi  lại  hình dáng)  Sử dụng để biên tập vùng ,  đường bao 
,đường điểm bằng di chuyển , thêm, xoá những nút tại định nghĩa đoạn đường
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2.12. Rounded Rectangle: Sử dụng để vẽ hình chữ nhật nhẵn, nếu giữ phím Shift thì 
vẽ hình vuông nhẵn.
2.13. Symbol: Sử dụng để tạo điểm và ghi ký hiêụ cho điểm đó.
2.14. Symbol Style (kiểu ký hiệu) Xem I.6.6.
2.15. Text: Sử dụng để ghi chú cho bản đồ và layout.
2.16. Text Style (kiểu văn bản) Xem I.6.11.
II.3. Tools ButtomPad.

3.1. Run Map Basic Program (chạy chương trình Map Basic) Xem I.1.10.
3.2. Show/Hide MapBasic Window (hiện/ ẩn cửa sổ MapBasic) Xem I.6.8.

III. Thuộc tính của các đối tượng bản đồ trong Mapinfo.
III.1. Line (Đường) đường được xác định bởi:

+ Kiểu đường
+ Toạ độ điểm đầu, điểm cuối, từ đó xác định được độ dài
+ Màu
+ Độ rộng (nét)
Trong Mapinfo để vẽ một đường từ vị trí này đến một vị trí khác giả sử cả 

hai vị trí này có toạ độ xác định, bạn có thể vẽ một đoạn bất kỳ sau đó sử dụng nút 
chọn (có hình mũi tên) bấm đôi trên đoạn đó Mapinfo xuất hiện hộp hội thoại Line 
Object để bạn thay đổi lại vị trí điểm đầu và điểm cuối của đoạn đường đó , ngoài ra 
bạn có thể thay đổi các thuộc tính khác bằng cách bấm vào nút Style trên hộp hội 
thoại Line Object hoặc vào Option > Line Style.
III.2. Point (điểm) : điểm được xác định bởi:

+ Toạ độ điểm.
+ Ký hiệu điểm (Symbol) gồm : kiểu ký hiệu, màu, độ lớn.
Trong Mapinfo để vẽ một diểm ở vị trí xác định giả sử vị trí này có toạ độ 

xác định , bạn có thể ghi điểm ỏ vị trí bất kỳ sau đó sử dụng nút chọn (có hình mũi 
tên) bấm đôi trên điểm đó Mapinfo xuất hiện hộp hội thoại Poin Object để bạn thay 
đổi lại vị trí điểm đó , ngoài ra bạn có thay đổi các thuộc tính ký hiệu bằng cách 
bấm vào nút Style trên hộp hội thoại Poin Object hoặcvào Options>Symbol Style.
III.3. Region (vùng) : vùng được xác định bởi:

+ Toạ độ của hình chữ nhật nhỏ nhất mà có thể bao được vùng đó (nếu vùng 
là hình chữ nhật thì toạ độ này là toạ độ xác định vùng).

+ Toạ độ tâm là toạ độ tâm hình chữ nhật ỏ trên .
+ Diện tích của vùng.
+ Chu vi của vùng.
+ Số đoạn tạo nên vùng.
+ Nền và màu nền của vùng.
+ Đường bao của vùng (kiểu đường, màu, độ rộng).
Để thay đổi các thuộc tính của vùng bạn sử dụng nút chọn và bấm đôi trên 

vùng Mapinfo xuất hiện hộp hội thoại Region Style bạn có thể thay đổi các thuộc 
tính: Toạ độ vùng bao, toạ độ tâm. Bạn thay đổi vùng bao để thay đổi nền, đường 
bao hoặc vào Options>Region Style.
III.4. Polyline: Xác định bởi các đường thẳng tạo nên vùng Polyline.

+ Toạ độ của hình chữ nhật nhỏ nhất mà có thể bao được vùng đó (nếu vùng 
là hình chữ nhật thì toạ độ này là toạ độ xác định vùng)

+ Toạ độ tâm là toạ độ của tâm hình chữ nhật ở trên
+ Độ dài của toàn bộ các cạnh toạ nên.
+ Số lượng cạnh tạo nên.
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Để thay đổi các thuộc tính của Polyline sử dụng nút chọn và bấm đôi trên 
một đối tượng đường bất kỳ của Polyline Mapinfo xuất hiện hộp hội thoại Polyline 
Style bạn có thể thay đổi các thuộc tính : Toạ độ vùng bao, toạ độ tâm, bấm vào nút 
Style để thay đổi đường bao hoặc vào Options>Line Style.
III.5. Text (văn bản): Các thuộc tính của văn bản gồm:

+ Vị trí, kích thước, màu, phông chữ, kiểu chữ, góc quay, cách đặt vị trí chữ .
Để thay đổi các thuộc tính của văn bản sử dụng nút chọn và bấm đôi trên một 

đói tượng của văn bản Mapinfo xuất hiện hộp hội thoại Text Style bạn có thể thay 
đổi các thuộc tính : có thể biên tật lại văn bản, toạ độ của văn bản, hiệu chỉnh vị trí 
văn bản nếu cần. Bấm vào nút Style để thay đổi Font chữ , kích thước chữ và kiểu 
chữ (đậm, ghạch chân, nghiêng) hoặc vào Options> Text Style.
IV. Hệ thống toạ độ của Mapinfo .
IV.1.  Accessing The Choose Projection Dialog (vào hộp hội thoại  để chọn lưới 
chiếu) Các bước chọn như sau:

+ Chọn Menu Map > Options khi đó hộp hội thoại Options hiển thị.
+ Bấm trên phím Projection khi đó hộp hội thoại chọn lưới chiếu xuất hiện 

và cho phép bạn chọn một lưới chiếu mà bạn muốn.
 Chú ý: Nếu dữ liệu ảnh đang đang được hiển thị trong cửa sổ bản đồ thì 

bạn không thể thay đổi được lưới chiếu 
IV.2. Exporting A Map In A Different Projection (Xuất bản đồ trong lưới 
chiếu khác) các bước như sau:
+ Chọn File > Save Copy As
+ Chọn bảng chứa bản đồ bạn muốn chép (nếu có hơn một bảng đang mở)
+ Kiểu tên cho bản chép của bạn
+ Chọn Save
+ Chọn Map Options khi đó hộp hội thoại Options hiển thị .
+ Bấm trên phím Projection khi đó hộp hội thoại chọn lưới chiếu xuất hiện.
+ Chọn một lưới chiếu mới cho bản chép của bạn.
+ Bấm OK khi ghi.
+ Chọn Table > Export. Sau đó theo sự hướng dẫn để xuất ra file kiểu MIF 
hoặc DXF.
IV.3. Saving A Copy Of Your Table In A Different Projection (ghi bản chép 
của bạn với lưới chiếc khác) các bước như sau:
+ chọn file > Save Copy As và ghi bản chep của bảng như hộp hội thoại 
được hiển thị. Khi bạn có hơn một bảng mở, chọn một bảng từ hộp hội thoại 
ghi bảng và ghi bản chép của bản như hộp hội thoại được hiển thị.
+ Kiểu tên của bảng mới trong hộp tên file của hộp hội thoại.
+ Chỉ ra thư mục mà file mới đó sẽ được ghi.
+ Bấm phím Projection và chọn lưới chiếu trong hộp hội thoại chọn lưới 
chiếu.
+ Chọ lưới chiếu bạn muốn sử dụng.
+ Bấm OK 
+ Mapinfo tạo ra bảng mới nhưng nó không mở được. Khi bạn muốn làm 
việc với bảng mới bạn cần phải lần đầu tiên mở nó sử dụng file > Open 
Table.
IV.4. Setting The Projection Of The Map (đặt lưới chiếu của bản đồ) phím 
Projectiontrong hộp hội thoại cài đặt bàn số hoá cho phép bạn vào hộp hội 
thoại chọn lưới chiếu ở đó bạn chỉ ra lưới chiếu của bản đồ mà bạn sẽ số hoá.
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IV.5. Specifying A New Table,s Attributes (chỉ rõ thuộc tính của một bảng 
mới) để chỉ ra bảng mới được hiển thị.
+ Chọn file > New Table và hộp hội thoại bảng mới hiện thị.
+ Kiểm tra mở bảng dữ liệu hoặc mở bnả đồ mới bạn cũng cần chọn thêm 
đến bản đồ hiện thời khi có một cửa sổ bản đồ đang tồn tại.
+ Bấm trên phím Create và hộp hội thoại cấu trúc bảng hiện thị. Khi bạn 
muốn tạo bảng chứa bản đồ và bắt đầu vẽ mà không chỉ ra trường dữ liệu, 
bạn cần đơn giản là nhập một trường dữ liệu vào trong cấu trúc của bảng mới 
khi  bạn tạo bảng của bạn,  sau  đó sử dụng Table> Maintenance  > Table 
Structure để thêm trường dữ liệu bạn muốn.
+ Chỉ ra lựa chọn cấu trúc bảng.
+ Chỉ ra lưới chiếu.
Bấm phím Projection và chọn lưới chiếu ở hộp hội thoại chọn lưới chiếu.
+ Chọn loại lưới chiếu từ liệt kê loại lưới chiếu.
+ Chọn lưới chiếu của laọi lưới chiếu vừa được chọn.
+ Bấm OK.
+ Chỉ ra toạ độ cho bản đồ phẳng.
+ Bấm phím Projection và chọn lưới chiếu ở hộp hội thoại chọn lưới chiếu.
+ Chọn loại lưới chiếu Non-earth từliệt kê laọi lưới chiếu và chọn đơn vị cho 
loại đó liệt kê chỉ ra giới hạn toạ độ phẳng được hiển thị. Nó cho phép chỉ ra 
giới hạn và đơn vị cho hệ thống toạ độ phẳng của bạn.
+ Chỉ ra tên cho bảng
Bấm trên phím Create để hiển thị hộp hội thoại tạo bảng mới.
+ Chỉ ra tên và đường dẫn cho bảng mới.
V. Vào dữ liệu cho bảng.
V.1. Importing DXF file (vào file DXF).
1.1. Choosing A Coordinate System For DXF Drawings (cho hệ thống toạ 

độ cho file DXF). Bạn cần chọn một hệ thống toạ độ (mặt dất hoặc toạ 
độ phẳng) cho file DXF của bạn. khi bạn không chọn hệ thống toạ độ 
thì khi vào dữ liệu file đồ thị Mapinfo tự động để toạ độ phẳng cùng 
đơn vị feet. Giới hạn của bản đồ là phạm vi của file DXF.

             + Chọn hệ thống toạ độ.
              Chọn Table > Import
Chọn File DXF cần đưa vào
Bấn phím Import và hộp hội thoại vào dữ liệu cho bảng hiển thị
Đặt tên cho bảng
bấm phím Save và hộp hội thoại thông tin vào từ file DXF được hiển thị.

+ Colors (màu) bạncó thể màu của kí hiệu cố định hoặc là màu có thể thay đổ khi 
đặt kí hiệu.
 + Cancel Symbol (bỏ qua việc tạo kí hiệu).
+ Exit Symbol (thoát khỏi chương trình ứng dụng tạo và biên tập kí hiệu).
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+ About Symbol (thông tin về chương trình Symbol).
VI. Xuất dữ liệu từ bảng (Exporting table).
VI.1. Autocad DXF Export (Xuất file DXF).
Sau khi bạn chọn được một bảng để xuất ra và chỉ ra kiểu dữ liệu hộp hội thoại 
thông tin DXF được hiển thị : nó không cần phải đặt  chuyển toạ độ khi xuất ra. Tuy 
thế bạn cần đặt chuyển đổi  toạ độ theo: 
Khi  bạn  làm việc  cùng bản  đồ  trong hệ  thống toạ  độ  không  có  trợ  giúp  theo 
Mapinfo.
Khi bạn đang làm việc cùng bản đồ trong hệ thống của toạ độ phi địa lí.
VI.2. Exporting A Map In A Defferent Projection (xuất bản đồ trong hệ thống lưới 
chiếu khác).
Bạn muốn xuất ra một bản đồ trong hệ thống lưới chiếu sự thay đổi theo thứ tự làm 
việc như trong thay đổi lưới chiếu cho một bảng trong mục III.
VI.3 Exporting A Single Table (xuất ra khi một bảng mở).
+ Chọn Table > Export và hộp hội thoại xuất bảng tới file xuất hiện.
+ Chọn thư mục để chứa file được đưa ra.
+ Tên file được xuất ra.
+ chọn kiểu file để đưa ra.
+ Bấm OK.
VI.4. Exporting More Than One Table (xuất ra khi có hơn một bảng mở)
Nếu có hơn một bảng đang mở thì bạn phải chọn một bảng nào cần đưa ra. Sau đó 
bạn làm
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